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Sdílení složitých návrhových informací nebylo nikdy 

dosud jednodušší. Návrhové soubory jsou často velké, 

zasílání výkresových sad a 3D modelů na tiskárnu nebo 

sdílení projektu s externími členy týmu vyžadovalo 

mnoho úsilí a času i systémových prostředků. Technologie 

DWF to vše mění. Na DWF založené návrhy jsou 

kompaktní, bezpečné a snadno použitelné. Díky sdílení 

rozsáhlých 2D a 3D návrhů sejmutých do DWF, kompletně 

digitální pracovní tok se stává skutečností – proud 

informací napříč celým týmem. 

Tato příručka DWF Tipy a triky poskytuje uživatelům 

potřebné informace i celým projektovým týmům ohledně 

DWF a aplikace jako je Autodesk Design Review. Další 

informace lze najít na ww.autodesk.com/dwf. 
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Schopnost publikovat DWF soubory 
je zabudována ve všech Autodesk 
aplikacích. Je zdarma dostupná ve všech 
dalších programech díky Autodesk  
DWF™ Writer. Další o publikování  
do DWF jsou uvedeny na  
www.autodesk.com/dwf-publishing.  

Publikování 3D DWF souborů

Použijte příkaz 3D DWF PUBLISH 
z AutoCADu (2006 nebo pozdější), 
Revitu nebo Inventoru pro publikování 
do 3D DWF formátu:  

1. Na příkazové řádce zadejte 
3ddwfpublish.  

2. V dialogu 3D DWF Publish, na záložce 
DWF jméno souboru změňte jméno 
a umístění DWF souboru, nebo 
použijte tlačítko [...] button  
pro určení nového umístění.  

3. Pod Objekty k publikování, zadejte 
jednu z následujících možností:  
•  všechny objekty modelového  
 prostoru  
•  vybrané objekty modelového  
 prostoru 

4. Jestliže výkres obsahuje externí  
reference, seskupování podle   
hierarchie je nastaveno jako výchozí.   
Odznačte volbu, jestliže nechcete 
zobrazit objekty seskupeny podle 
hierarchie v publikovaném DWF 
souboru.  

5. Pod Vybrat jednotlivé objekty 
vyberte jednu z následujících metod 
seskupování objektů v DWF souboru:

   •  podle hladiny  
•  podle typu objektu /např. podle  
 bloku) 

6.  Stiskněte OK. 

Publikování
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Přidání Vlastností objektů z bloků 
AutoCADu

Umožněte členům týmu přístup  
k hodnotám bloků AutoCADu v DWF 
souboru nastavením voleb publikování.  

1. Z menu Soubor vyberte Publikovat.  

2. V dialogu Publikuj, na záložce 
Publikovat kam, vyberte DWF soubor 
a zvolte Možnosti publikování. 

3. V dialogu Možnosti publikování,  
pod volbou DWF data, informace  
o bloku vyberte Zahrnout  
z rozbalovacího seznamu. *   

4.  Stiskněte OK  

5.  V dialogu Publikuj buďto pokračujte 
s publikováním nebo dialog uzavřete.

 * Výchozí nastavení je Nezahrnout informace 
o blocích. Jestliže změníte nastavení  
a zahrnete tyto informace, můžete použít 
prohlížeč pro prohlížení či tisk vlastností bloků 
a atributů v DWF souboru. 

Zvýšení přesnosti DWF souboru

Určete rozlišení v pixelech pro vektorovou 
a rastrovou grafiku při vytváření DWF 
souboru. Čím vyšší rozlišení, tím lepší 
přesnost, ale o to větší velikost souboru. 

1. Z menu Soubor vyberte Tisk.  

2. Ujistěte se, že je vybrána tiskárna DWF 6 
ePlot.pc3. Zobrazte její Vlastnosti.  

3. Vyberte Grafika ze seznamu a rozbalte ji. 
Vyberte tlačítko Uživatelské vlastnosti.   

4. Nastavte Vektorové rozlišení  
na požadovanou hodnotu. Další hodnoty 
(Gradient, Barvy a Odstíny šedi, Černá 
a Bílá můžete ponechat tak jak jsou. 
Platné hodnoty z rozbalovacího menu 
jsou od 150 do 4800. Pomocí klávesnice 
zadejte vaši hodnotu, např. 30270. 

Přehled užitečných a doporučených hodnot 
najdete na stránce dwf.blogs.com.
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Publikování DWF a e-mail 
komunikace z Průzkumníka Windows

Odeslání DWF souboru je jednoduché 
za pomoci aplikace Autodesk DWF 
Writer.  

1. Otevřete Průzkumníka Windows  
a otevřete složku obsahující soubor 
určený k publikování  
a pro elektronickou poštu  

2. Klikněte pravým tlačítkem  
na souboru a vyberte Publish DWF 

and Email. Otevře se výchozí  
e-mailová aplikace s novou poštovní 
zprávou a připojeným souborem 
DWF. Do předmětu se doplní jméno 
DWF souboru. 

3. Zadejte adresy příjemců zprávy, 
popř. doplňte zprávu o další text. 
Automaticky se doplní link a stažení 
prohlížeče Autodesk DWF Viewer.

4.  Zadejte odeslat.
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Publikování z aplikací SolidWorks, 
Pro/ENGINEER Wildire a Catia

Mainstalujte Autodesk DWF Writer 3  
pro publikování 3D modelů  
a návrhových dat z aplikací    
SolidWorks  2006, Pro/ENGINEER 
Wildire 2.0 a CATIA V5.  

1. Z menu Soubor vyberte Publikuj 
DWF, automaticky se přepne 
prostředí na 2D výkres nebo 3D 
model do DWF.  

2. Více informací najdete na adrese 
www.autodesk.com/dwf-publishing.  

Publikování z aplikace Microsoft 
Office

S nainstalovaným Autodesk DWF 
Writer mohou uživatelé publikovat 
soubory DWF z aplikací Microsoft® 
(PowerPoint®, Word, Excel®, Visio®, 
Outlook, a Internet Explorer) a sdílet 
data jako součást projektové sady. 
  

1. Klikněte na tlačítko Publikuj DWF  
v liště aplikace Microsoft nebo  
z menu Soubor vyberte Tisk a zadejte 
Autodesk DWF Writer ze seznamu 
dostupných zařízení.  

2. Určete jméno a umístění výstupního 
DWF souboru

3. Klikněte na uložit nebo ukončit tisk.
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V minulost prohlížení návrhových dat 
vyžadovalo zakoupení plné licence 
CAD software. Nyní je k dispozici 
zdarma ke stažení aplikace Autodesk  
DWF™ Viewer. Kdokoli může procházet 
výkresové sady, zpřístupnit si údaje 
návrhu, a tisknout to, co potřebuje. 
  

Stáhněte si Autodesk DWF Viewer  
z adresy www.autodesk.com/dwfviewer-
download. 

Rychlý Zoom a Pan

Použijte prostřední tlačítko myši 
(otočné) pro zoomování. 

Pro posun stiskněte prostřední tlačítko, 
a posouvejte myší. 

Poznámka: možná bude potřeba upravit 
nastavení myši pro toto chování  

Otáčení 3D DWF souborů 

1. Zvolte Choose View 
a potom vyberte orbit pro 
spuštění nástroje Orbit.  

2. Klikněte na 3D modelu a otáčejte 
požadovaným směrem.

3. Zvolte Standard Views a prohlížejte 
zepředu (Front), zezadu (Back), nebo 
zapněte stínované hrany Shaded 
Edges.

Prohlížení a vyhledávání  
návrhových dat 

1. V Průzkumníkovi Windows klikněte 
na Vyhledat  

2. Napište hledaný termín pro DWF 
soubor jako jsou dveře, šroub apod.  

3. Vyberte umístění k prohledávání  
a stiskněte Hledat nyní.

4.  Microsoft Windows Explorer 
vyhledá seznam DWF souborů, které 
obsahuje hledaný termín. 

Prohlížení a tisk
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Levý panel zobrazí text jako instrukce 
krok za krokem.

Rozpad 3D sestavy

Uživatelé Autodesk Design Review 
and DWF Viewer mohou prohlížet 
3D modely z Autodesk aplikací nebo 
vytvořených pomocí volně šiřitelného 
Autodesk DWF Writer. Následujte tyto 
kroky pro otášení a rozpad jednotlivých 
částí modelu:

1. Z menu Nástroje (Tools), vyberte 
Posunout > Otočit (Move)>(Rotate).   

2. V paletě Model nebo v ploše 
zobrazení klikněte na součásti, které 
chcete posunout nebo otočit. 

Prohlížení montážních instrukcí

Při prohlížení animovaných DWF souborů 
s montážními instrukcemi otevřenými  
v Autodesk DWF Viewer nebo Autodesk  
Design Review, instrukce jsou zobrazeny 
jako aktuální úkol nebo sekvence v levém 
panelu pod plochou plátna (Canvas).

Důležitá informace: I když otvíraný DWF 
soubor obsahuje textová data, panel s daty 
samotnými se neotvírá automaticky. 
Použijte rozbalovací seznam Pane Layout 
pro zobrazení požadovaných panelů.

Pro zobrazení panelu Text nebo Grid 
proveďte:   
  

1. Klikněte na rozbalovacím seznamu panelů.   

2. Vyberte si z: 
 •  zobrazit Canvas a Grid panely    

•  skrýt Data panel   
 •  skrýt Canvas panel     
 •  zobrazit všechny planely  

DWF View a Design Review zobrazí takovou 
konfiguraci panelů, jakou jste si navolili. 
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Otáčení
Klikněte poblíž konce osy, kolem 
které chcete součást otáčet, a myší 
zatáhněte okolo osy. Zatáhněte  
do jednoho nebo druhého směru.  
Nebo použijte šipku Dolů z klávesnice 
pro otočení dolů o jeden stupeň 
nebo šipku Nahoru pro otočení 
o jeden stupeň nahoru. Pro otočení 
o 45° stiskněte a držte klávesu Shift 
současně s šipkami z klávesnice. 

  3. Odstranit součást z výběru lze pomocí 
stisknutého tlačítka Ctrl a znovu kliknutím 
na součást (Ctrl+kliknutí). V paletě Model 
použijte kombinaci Shift+kliknutí na první 
a poslední součást pro výběr sousedících 
součástí v jednom celku. 

Posun podél osy
Klikněte poblíž konce osy, podél které 
chcete posunout součást. Zatáhněte 
do jednoho nebo druhého směru. Nebo 
stiskněte na klávesnici šipku Nahoru  
pro posun od počátku nebo šipků Dolů  
pro posun směrem k počátku osy.  

Posun uvnitř plochy
Pohybujte kursorem nad plochou určenou 
dvěma osami až se objeví ikona plochy se 
šipkami, potom klikněte myší. Zatáhněte 
součást jakýmkoli směrem.  

Posun souběžně s obrazovkou
Klikněte na počátek, a zatáhněte součástí 
jakýmkoli směrem. Nebo použijte šipky  
na klávesnici pro pohyb vpřed, vzad, doleva 
či doprava. 
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Posun podél osy
Klikněte poblíž konce osy, podél které 
chcete posunout součást. Zatáhněte  
do jednoho nebo druhého směru.  
Nebo stiskněte na klávesnici šipku 
Nahoru pro posun od počátku 
nebo šipků Dolů pro posun směrem 
k počátku osy.   

Posun uvnitř plochy
Pohybujte kursorem nad plochou 
určenou dvěma osami až se objeví 
ikona plochy se šipkami, potom 
klikněte myší. Zatáhněte součást 
jakýmkoli směrem. 

Posun souběžně s obrazovkou
Klikněte na počátek, a zatáhněte 
součástí jakýmkoli směrem. Nebo 
použijte šipky na klávesnici pro pohyb 
vpřed, vzad, doleva či doprava. 

Otáčení
Klikněte poblíž konce osy, kolem 
které chcete součást otáčet, a myší 
zatáhněte okolo osy. Zatáhněte  
do jednoho nebo druhého směru.  

Tvorba 3D řezů 

Rozřízněte model řeznou rovinou 
a manipulujte pohledem různými směry 
posouváním a otáčením řezné roviny 
a sledováním pohledu.  
  

1. Otevřete model a z menu Nástroje (Tools) 
vyberte Řezná rovina (Cross Section>XY  

 Section, YZ Section, nebo XZ Section).    

2. Průhledný fialový list (řezná rovina) 
a trojnožka jsou umístěny do středu 
modelu, tím jej rozříznou a odhalí vnitřek 
modelu. Posouvejte nebo otáčejte řeznou 
rovinou pro odhalení jiných částí modelu.

3. Tři osy trojnožky se setkávají v bodě, 
který se nazývá počátek. Změna počátku 
viditelné části se provede posunutím nebo 
otočením řezné roviny ze její počátek. 
Objeví se uzly, z nichž každý dovoluje 
uživateli pohyb řezné roviny různými 
způsoby. 
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Nebo použijte šipku Dolů z klávesnice 
pro otočení dolů o jeden stupeň 
nebo šipku Nahoru pro otočení 
o jeden stupeň nahoru. Pro otočení 
o 45° stiskněte a držte klávesu Shift 
současně s šipkami z klávesnice. 

Vrácení rozpadu 3D modelu nebo 
tvorby řezů 

Aplikace Autodesk Design Review a DWF 
Viewer obsahují výkonné funkce rozpadu 
modelu a řezu 3D modelu. Ačkoli jsou 
tyto funkce snadno dostupné a velmi 
výkonné, někteří uživatelé nemusí vědět 
jak je vrátit zpět. Po provedení řezu či 
rozpadu části modelu z jeho původního 
umístění mohou uživatelé obnovit 
původní pohled na model takto: 

Pohled (View)->Go->Home. 

Zkratka pro tuto funkci je Ctrl+ G.

Zpřístupnění inteligence návrhu 

Zpřístupněte inteligenci dat návrhu 
z programů Autodesk Architectural 
Desktop 2004® a novější,  
na AutoCADu 2007® založených 
produktů, a Autodesk Inventoru,  
pro prohlížení v Autodesk Design Review 
nebo DWF Viewer. 

1. Prohlížení a třídění vlastností objektů: 
klikněte na okno Vlastnosti. 
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Užití operativních tiskových voleb 

Prohlédněte si tiskovou úlohu před 
odesláním na tiskárnu. Partnerství  
s výrobci tiskáren jako jsou HP nebo 
Óce pomůže zajistit rychlý, vysoce 
kvalitní výstup.  
  

1. Tisk do specifikace: 
 Upravte si nastavení, které ovlivní 

výstup ze standardního na velký 
formát. Vybírejte z následujících 
možností:

2. Prohlížení informací bloků: v okně 
Content Browser vyberte okno 
Vlsatnosti (Properties) potom vyberte 
vlastnosti objektu (Object Properties) 
z rozbalovacího menu. 

 Klikněte na výběrové tlačítko 
a určete blok, jehož vlastnosti 
chcete zobrazit.  

3. Vyhledávání návrhových dat: v Microsoft 
Průzkumníkovi Windows®: zvolte Hledat, 
zadejte hledaný řetězec pro nalezení dat 
v souborech DWF, jako je např. šroub, 
dveře atd.

4.  Navigace mezi listy nebo pohledy použitím 
hyperlinků: Z hlavního menu vyberte 
View>Show>Hyperlinks (Ctrl+H)  
pro zobrazení hyperlinků modrou barvou. 
Následovat hyperlink lze stisknutím 
klávesy Ctrl a kliknutím na jeho odkaz. 
Otevře ten soubor, výkres nebo 
internetová stránka, do které je linkován.  
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  Poznámka: tlačítko se objeví   
 automaticky, pokud se připojíte  
 k podporované HP® Designjet™  
 tiskárně.

   
 •  optimální nastavení tisku je 

zvoleno podle vlastností DWF 
souboru 

Ukázka v aplikacích Microsoft Ofice   
Sdílejte ucelený záměr designu  
v Microsoft PowerPoint, Excel,  
nebo Word ať už jde o  prezentaci  
u zákazníka, dokumentaci výrobku 
nebo kusovník   
  

1. Přetáhněte soubor z Průzkumníka 
Windows do dokumentu.

2. Nebo z menu Insert menu, zvolte 
Objekt a Autodesk DWF Viewer 
Control, potom stiskněte pravé 
tlačítko a vyberte Autodesk DWF 
Viewer Control Object Properties 
pro začlenění interaktivního DWF 
souboru.

 •  celá stránka nebo aktuální pohled     
•  velikost papíru nebo použít velikost   
papíru podle DWF   

 •  na výšku nebo na šířku      
 •  roztáhnout na stránku nebo tisk  

 v měřítku
 •  na výšku nebo na šířku      
 •  dlaždicový tisk na více stran 

2. Náhled před tiskem: 

 •  z menu File, vyberte Print, otevře se   
 dialogový panel Print   

 •  nastavte náhled tak jak potřebujete,   
 jako např. tisk na výšku či na šířku       

 •  klikněte na tlačítko Show Print Preview

3. Rychlý tisk na tiskárny HP: 

 •  klikněte na tlačítko HP  
 Instant Printing 
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Umístění souborů do služby 
Autodesk Buzzsaw   
Autodesk Design Review a DWF 
Viewer jsou plně integrovány řešení 
řízení projektu  Autodesk  Buzzsaw. 
Postupujte podle těchto kroků:   
  

1. Přetáhněte DWF soubory do složky 
projektu.

2. Informujte členy projektu pomocí 
systému Buzzsaw. Změny a verze jsou 
automaticky sledovány.

Už nikdy více prohlížení faxů a e-mailů 
pro ručně získanou zpětnou vazbu. 
S Autodesk Design Review software 
mohou členové týmu prohlížet, 
odměřovat a komentovat návrhy, 
a přenést poznámky a změny zpět  
do původní návrhářské aplikace.  
Všechny změny jsou automaticky 
sledovány a kontextu designu. 

Přesné odměřování

Nástroj kótování s funkcí AutoSnap™ 
pomáhá členům týmu zjistit délky, 
křivky a plochy
 

1. Uchopení na koncový bod: 
 Nastavte odměřovací nástroj  

pro uchopení koncových 
a středových bodů geometrie  
pro přesné odměřování prvků návrhu 
v DWF souboru. Klikněte na příkaz 
Tools a zapněte funkci Snap to 
Geometry. 

Prohlížení, 
odměřování 
a komentování
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Práce s rozšířenými komentáři  
a poznámkami

Autodesk Design Review obsahuje 
snadno použitelné tvary, texty, razítka, 
kreslení od ruky a uživatelské symboly 
navíc ke značkovacích nástrojů.  

1. Ovládání tvaru poznámky:  
 držte klávesu Shift pro zavazbení 

poměru stran poznámky při jejím 
vytváření 

   
 •  před opakováním stiskněte klávesu  

 Esc a zkuste znova

    •  vymazat poznámku lze pomocí  
 Selection tool a potom stiskněte  
 Delete

2. Přiblížení pro větší přesnost: Pro dosažení 
větší přesnosti přibližte zobrazení té části 
výkresu, kde je počáteční a koncový bod 
kóty.
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Použití uživatelských symbolů  
a razítek

Použijte symboly pro komentování 
informací v kanceláři či v terénu. 

  
1. Vytvoření uživatelského katalogu 

symbolu: Publikujte 2D výkres, 
obrázek nebo text do DWF souboru 
s použitím Autodesk DWF Writer.  
V aplikaci Autodesk Design Review, 
importujte tento soubor do katalogu 
symbolů.

 
 •  Z panelu nástrojů vyberte  

 tlačítko Stamps and  
 Symbols

2. Barevné odlišení poznámek:  
 používejte různé barvy pro různé 

uživatele 
   

 •  Vyberte si ze 48 předefinovaných barev  
 nebo si vytvořte vlastní 

    •  Změňte barvu textu a úseček v hlavním  
 menu, a potom klikněte  
 na požadovanou barvu 

3. Uložení nového pohledu:  
 Když vytvoříte novou poznámku, aktuální 

pohled na výkres je uložen spolu s ní. 
Pokud chcete změnit a automaticky uložit 
nový pohled, nastavte pohled podle 
potřeby a mírně posuňte poznámku nebo 
ji jinak mírně upravte.  
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Řízení projektu z jednoho místa

Práce s více typy dokumentů v jednom 
vícelistovém souboru DWF, kombinující 
obrázky, náčrty, časové termíny, specifikace, 
kusovníky a další informace o projektu. 
  

1. Sejmutí informací nástrojem Snapshot: 
Přidejte snímek k existujícímu DWF 
souboru, nebo vytvořte nový DWF soubor 
přidáním jednoho nebo více snímků.

 
 •  klikněte na tlačítko Snapshot 

 •  nastavte snímanou oblast obrazovky
 
 •  klikněte na tlačítku Capture  

 v panelu ikon

2.  Metoda „Drag and drop“:  lze spojit 
DWF soubory, rastry a další informace 
o projektu do jednoho DWF souboru 
a zašlete jej k připomínkování

 •  metoda „Drag and drop, nebo zvolte  
 v menu File>Open pro prohlížení  
 a komentování mnoho rozdílných typů  
 souborů jako jsou GIF nebo JPEG   
 obrázky 

 •  pokračujte položkou z menu Select   
 Import DWF as Symbol Catalog

 •  nalistujte a vyberte DWF soubor   
 obsahující váš symbol, a stiskněte Open  
 nebo Enter 

  
2. Vytvoření vlastních razítek: Vytvořte 

uživatelskou poznámku a razítko 
dvojklikem a napište nebo změňte 
požadovaný text podle potřeby.  
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2. Na panelu Standard zobrazte 
rozbalovací tlačítko Callout.  

3. Klikněte na nástroj Grid Snapshot.  

4. Snímek kusovníku je přidán do palety 
Contents.

5. Vyberte BOM Snapshot v paletě 
Contents pro přidání poznámek.

 •  přetáhněte stránku nebo stránky  
 do e-mailové zprávy nebo na plochu  
 pro vytvoření nového DWF souboru

Připomínkování kusovníků a rozpisek

Nástroj Grid Snapshot v aplikaci Autodesk 
Design Review, lze použít pro sejmutí 
kusovníků a rozpisek na jednotlivých listech 
pro připomínkovací účely. 
  

1. Kusovník musí být načten v panelu Grid 
Data pod plátnem aby bylo možno snímat
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Využijte tyto pokročilé DWF tipy  
od expertů.

Tipy pro Autodesk DWF Viewer

1. Používejte kolečka myši pro zoom 
– přiblížení a oddálení obrazu. 
Posouvat lze stisknutím prostředního 
kolečka a posunem myši.   

2. Pomocí Options Content Browseru 
lze přepínat mezi zobrazením 
náhledů, seznamu pohledů nebo 
záložek v původních datech DWF

3. Při otáčení 3D objektů přidržte 
trojnožku mírně našikmo k obrazovce 
pro posun nebo otočení. Nelze 
posunout nebo otočit osu, která míří 
přímo proti vám. 

Instalujte v celé společnosti

Autodesk DWF Viewer může být 
instalován v tichém režimu pomocí 
příkazu:
msiexec /i SetupDWFViewer.msi /qn
Vaše IT oddělení může instalovat 
Autodesk DWF Viewer v celé 

společnosti. Tichou instalací Autodesk 
DWF Vieweru může být prohlížeč 
zahrnut jako součást firemního 
automatického instalačního balíčku. 
Například, toto je částečně užitečné 
při instalaci Autodesk DWF Vieweru 
celopodnikově pomocí SMS.  

Integrace Autodesk DWF Vieweru  
v HTML Documentech

Autodesk DWF Viewer je dostupný 
jako prvek ActiveX  který je vložen 
v Microsoft Internet Exploreru, 
poskytujícím hladkou instalaci volně 
šiřitelného Autodesk DWF Vieweru  
na internetových stránkách.   

1. Integrujte DWF soubory přímo  
do internetových stránek pomocí tagu 
<object>. 

Pokročilé tipy
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Tisk DWF souborů na tiskárny Océ

Některé Océ tiskárny (např. TDS800, 
TDS600, or TDS400) mají jako výchozí 
nastavení ořezání DWF výtisků. Existuje 
volba v ovladači Océ Windows Raster Driver 
pro přepsání ořezávací metody v the Power 
Logic Controller. V dialogu Printing Defaults 
je záložka Delivery”.  Tam jsou tři metody 
ořezu: 
  

1. Synchro: ořezává na velikost tisku

2. Standard: ořezává na standardní velikost 
papíru 

3. Printer default: Použije to, co je nastaveno 
jako výchozí v kontroleru.

Při tisku DWF souborů by měla být 
nastavena možnost “Standard” změnou 
vlastností tiskárny. 

Při tisku na zařízení Océ 9800 nebo Océ 
TDS800 někteří uživatelé zjistili, že pokud 
architekti nebo inženýři použijí pero    
v jejich výkresech AutoCADu, publikované 
DWF soubory budou velmi slabé při tisku  
na těchto zařízeních, (zvláště šrafy a výplně). 

2. Zpřístupněte, kopírujte a vložte příklad 
HTML, který demonstruje, jak vložit DWF 
soubor v HTML: 

 http://dwf.blogs.com/beyond_the_
paper/2006/05/how_do_i_embed_.html

Ukládání prohlídnutých DWF souborů

Proveďte následující kroky pro uložení 
lokální  kopie DWF souborů vložených  
na internetové stránky: 
  

1. klikněte pravým tlačítkem na soubor 
DWF a zadejte Uložit jako. Nebo, vyberte 
příkaz Uložit jako z menu Soubor. 
(Poznámka: Volba Uložit jako se objeví 
jen tehdy, pokud používáte DWF Viewer 
v integrováném módu, v internetové 
stránce.) 

2. Uložení dokončete určením jména 
souboru.
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Užitím módu “Poster Mode” v těchto 
výkresech se tento problém odstraní.  

Použití API pro úpravy a rozšíření 
funkčnosti

Použijte Autodesk Design Review a DWF 
Viewer aplikační rozhraní (API)  
pro zakomponování Design Review 
nebo DWF Vieweru v internetových 
stránkách nebo v apikacích třetích stran. 
Dokumentace poskytuje instrukce jako jsou 
navigace na určitou stránku nebo pohled, 
ovládání stavu hladin, schopnost zobrazit 
či skrýt toolbary a kontextová menu, 
stejně jako např. řízení chování prohlížeče. 
Více informací najdete na www.autodesk.
com/dwf-developers, kde lze stáhnout 
i dokumentaci pro API.

Další informace

Navštivte DWF Center  
www.autodesk.com/dwf 

Navštivte DWF Blog  
dwf.blogs.com 

Zúčastněte se diskusních skupin 
www.autodesk.com/ 
designreview-discussion 
www.autodesk.com/dwf-discussion

Ke stažení zdarma  
www.autodesk.com/ 
dwfviewer-download 
www.autodesk.com/designreview-trial  
www.autodesk.com/dwfwriter  

Informace o produktech 
www.autodesk.com/designreview 
www.autodesk.com/dwfviewer 
www.autodesk.com/dwf-publishing 

Nástroje a informace pro vývojáře  
www.autodesk.com/dwf-developers 
www.autodesk.com/dwftoolkit  

Vyzkoušejte náš nejnovější software  
labs.autodesk.com 
dwit.com
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 “Skutečně, DWF a Autodesk Design Review  
nám pomáhají zvýšit produktivitu.” 
 

— Patrik Chartrand, CAD Administrator  
     Advanced Dynamics 


